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FAAC PROPRIETARY SOFTWARE LICENSE

THE SOFTWARE PROVIDED WITH YOUR DRIVING SIMULATOR IS COPYRIGHTED AND FAAC
INCORPORATED CLAIMS ALL EXCLUSIVE RIGHTS TO SUCH SOFTWARE, EXCEPT AS
LICENSED TO USERS HEREUNDER AND SUBJECT TO STRICT COMPLIANCE WITH THE TERMS
OF THIS LICENSE. PLEASE READ THIS LICENSE CAREFULLY BEFORE USING THE
SOFTWARE. BY USING THE SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS
OF THIS LICENSE.

Use of the Software listed above is subject to the terms and conditions hereinafter set forth.

I. License Grant/Use

A. Subject only to license and other rights that FAAC may explicitly confer upon the U.S.
Government, foreign governments or third parties, Licensee hereby acknowledges and agrees that:
(a) all software, whether or in source code or object code format, related documentation, and other
works owned, developed, written, authored, purchased, created, or modified by FAAC (“FAAC
Proprietary Works”) and delivered to Licensee pursuant to this Agreement or any resultant
Subcontract Agreement shall remain the exclusive property of FAAC and/or any third party suppliers
of FAAC. FAAC (and, if applicable, its third party suppliers) shall own all copyrights, patents, trade
secrets, trademarks and other intellectual property rights, title and interest in or pertaining to the
FAAC Proprietary Works. Licensee shall not remove or destroy any proprietary markings of FAAC,
including, but not limited to, legends and notice of FAAC’s ownership and title to trademarks, trade
names, trade secret, copyrights or patents placed upon or contained within the FAAC Proprietary
Works and to reproduce all such markings upon or within authorized copies of the FAAC Proprietary
Works.

B. Licensee shall be prohibited from conferring any license or other rights in the FAAC Proprietary
Work on behalf of FAAC to: (a) the U.S. Government under the U.S. Federal Acquisition
Regulations, U.S. Defense Acquisition Regulation System, or other applicable law, (a) any foreign
government under corresponding government procurement law, or (c) other third party under
intellectual property right or other applicable law without the express written consent of FAAC as to
the nature and scope of the license and right granted in the FAAC Proprietary Work.

C. The license granted hereunder conveys to the Licensee the right to use the Software only on the
designated system as specified above. For purposes of this agreement, the System is defined as the
computer system used to execute the program code generated by the Software

D. Licensee agrees that it will not in any form export, reexport, resell, ship or divert or cause to be
exported, reexported, resold, shipped or diverted, directly or indirectly, the Software or a direct
product thereof to any country for which the U.S. Government or any agency thereof at the time of
export or reexport requires an export license or other governmental approval without first obtaining
such license or approval.
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II. Copies

A. Copyright Notice

Licensee acknowledges that FAAC claims copyright in the United States on the Software and
manuals. Licensee will maintain FAAC's copyright notice on the Software and manuals and will
mark all authorized copies of the Software and manuals with a copyright notice indicating FAAC's
ownership in such manner as FAAC may designate. Placing of such copyright notice shall not be
deemed a publication or placement in the public domain.

B. Limitations

Licensee agrees that it shall not print or copy, in whole or in part, in any media, any Software under
this license except for backup and archival purposes.

Licensee agrees that title to the original copy of all Software furnished and all copies and
modifications thereof made by the Licensee is and shall remain in FAAC.

Licensee shall neither reverse engineer, decrypt, disassemble, nor decompile FAAC Proprietary
Works in object code format without FAAC’s prior written consent, which shall be revocable at any
time upon written notice to Licensee. Licensee shall neither make nor create “derivatives” to the
FAAC Proprietary Works without FAAC’s prior written consent, which shall be revocable at any
time upon written notice to Licensee. Licensee agrees to notify and consult with FAAC with respect
to any proposed creation of “derivatives” to FAAC Proprietary Works prior to Licensee’s creation of
the same. The term “derivatives,” as used herein, includes but is not limited to any modifications,
revisions, enhancements, error corrections, or bug fixes to the FAAC Proprietary Works, including
Graphical User Interfaces and Application Programming Interfaces created for the FAAC Proprietary
Works. Notwithstanding FAAC's consent or the lack thereof, FAAC shall own all rights, title and
interest in derivatives of FAAC Proprietary Works created by Licensee or its agents.

C. Proprietary Notice

Licensee agrees to include FAAC proprietary notice on all copies, in whole or in part, and in any
form made by the Licensee under this license.

III. Term

This license is effective from the date of execution by FAAC and shall remain in force until
cancelled by reason of the Licensee's failure to comply with any of the terms and conditions set forth
herein, and subject to the cancellation provisions in Paragraph IX. Licensee's obligation hereunder
with respect to maintaining confidential information shall survive the cancellation of this license.

IV. Unauthorized Use of FAAC Software or Licensed Software

Any use of the Software not in accordance with the express provisions of this license is
unauthorized.

V. Protection and Security

FAAC represents that the Software constitutes confidential information and Licensee agrees not to
disclose any Software in any form to any person other than FAAC or the Licensee's employees
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having a need to know without prior written consent from FAAC. Furthermore, Licensee will use its
best efforts to keep all such information confidential, and shall use all reasonable measures to
prevent any unauthorized use, copying, publishing, reproducing, or disclosure of Software.

VI. Software License Rights of FAAC

Nothing contained herein shall give Licensee any interest of any kind in the Software except the
right to use the Software in accordance with the terms of this license.

VII. Patent and Copyright Indemnification

A. Defense of Claims, Costs and Damages

Subject to the limitation of liability contained in Paragraph XII, FAAC will defend at its expense any
action brought against the Licensee to the extent that it is based on a claim that the Software, used
within the scope of this license, infringes upon a United States patent or copyright, FAAC will pay
any costs and damages finally awarded in such suit or proceeding against the Licensee which are
attributable to such claim; provided, prompt notice is given to FAAC and FAAC is allowed full
control of the settlement of any such claim, and Licensee provides all reasonable assistance at no
cost to FAAC.

B. Infringement

Should the Software become, or in FAAC's opinion be likely to become, the subject of a claim of
infringement of a copyright or patent, FAAC may at its option (i) procure for the Licensee the right
to continue using the Software, (ii) replace or modify the Software to make it non-infringing while
providing the same functionality, or (iii) if the right to continue cannot be reasonably procured or the
Software cannot be reasonably replaced or modified, then terminate the license to use such Software
and refund the purchase price of the software and the hardware whose operation depends on such
software, less depreciation at 20% per year.

C. Limitation on Liability

FAAC shall have no liability for any claim of copyright or patent infringement based on:

1) Use of other than the latest unmodified release of the Software from FAAC if such infringement
could have been avoided by the use of the latest release of the Software, provided that the
Licensee is notified by FAAC that the earlier release of the Software is infringing, the Licensee
is provided with a later release of non-infringing, compatible Software, and the Licensee elects
to continue using the infringing Software; or

2) Use or combination of the Software with any non-FAAC programs or data.

FAAC shall have no liability for any claim of copyright or patent infringement where the claim
arises out of special requirements of the Licensee or is the result of special application or use to
which the FAAC Software is put by the Licensee or others. This Paragraph VII states the entire
liability of FAAC with respect to infringement of any copyrights or patents by the Software or any
parts thereof.

VIII. Injunctive Relief; Waiver
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The Licensee agrees that any failure to comply strictly with the terms of this License Agreement will
cause irreparable harm to FAAC, and that FAAC is entitled, in addition to any other rights and
remedies it may have, at law or in equity, to an injunction enjoining and restraining the Licensee
from continuing to use the Software and/or from doing any such act and any other violations or
threatened violations of this license. Licensee agrees that Seller's waiver of breach of any provision
of this license shall not be deemed waiver of any preceding or succeeding breach of the same or any
other provision of this license.

IX. Cancellation

Any failure by Licensee to comply with the obligations imposed upon Licensee by this License
Agreement shall be deemed to be a Default. In the event of a Default, FAAC may, after giving thirty
(30) days written notice to Licensee, cancel any or all of the licenses granted hereunder, unless the
latter corrects such Default within such thirty (30) day period.

X. Return on Cancellation

Within thirty (30) days after the cancellation of the license granted hereunder, Licensee shall deliver
to FAAC all Software and copies thereof, or if this is not possible, shall destroy all Software and
copies thereof and so certify in writing to FAAC.

XI. Warranty

A. General Warranty

Software will conform to FAAC's Functional Specification prevailing at the time of the shipment.
FAAC will correct all reported substantial non-conformities in unaltered Software for a period of
ninety (90) days from date of shipment, provided such reports are made in accordance with FAAC's
standard reporting procedure and such non-conformities are confirmed by FAAC. Correction of
non-conformities may, at FAAC's discretion, consist of any combination of the following: written
instructions for installing minor patches, automatic patch capability on Documentation to reflect
operating limitations provided that such limitations do not limit the specified guaranteed
performance of the Software.

B. Warranty Limitation

The express warranty stated above is in lieu of all other warranties, and FAAC disclaims all other
warranties, either express or implied, including all implied warranties of merchantability or fitness
for a particular purpose, and the stated express remedies are in lieu of all other remedies, liabilities or
obligations of FAAC for damages including, but not limited to, incidental, indirect, special, or
consequential damages, such as interruption of business or any loss of business or profits, loss due to
personal injury, or harm to property, or any expense experienced by the Licensee or his customer
arising out of any defects in or failure or inadequacy of performance of any product furnished by
FAAC hereunder.

XII. Limitation of Liability

FAAC's liability to the Licensee for damages hereunder, excluding any liability for copyright or
patent infringements, regardless of the form of the action, shall not exceed the charges paid by the
Licensee for the particular licensed Software or related material. FAAC's liability to the Licensee for
damages for copyright or patent infringement shall not exceed the purchase price of the equipment
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incorporating such licensed software. No action, regardless of form, arising out of the transactions
under this license may be brought by Licensee more than one (1) year after the cause of the action
has accrued.

XIII. Rights in Data

For U.S. Government Customers Only: This License Agreement is entered into pursuant to DFARS
252.227-7013(c) and FAAC is authorized to apply the Restricted Rights Legend to all computer
software and related software documentation identified on the first page of this Agreement. FAAC
understands and agrees that any modifications to the computer software and related documentation
listed on the first page, which are made at Government expense, shall be furnished, if required,
subject to Unlimited Rights.

XIV. General

A. In case any one or more of the provisions contained in this license shall, for any reason, be held to be
invalid, illegal, or unenforceable in any respect, such invalidity, illegality or unenforceability shall
not affect any other provision of this license, but this license shall be construed as if such invalid,
illegal, or unenforceable provision had been deleted.

B. Additional FAAC Software products, Licensed Software products, or Simulators may be added to
this license at any time by mutually acceptable additions to the lists of software in the first paragraph
above.

C. The heading contained in this license are for reference only and shall have no substantive effect.

D. The Licensee's remedies in this license are its sole and exclusive remedies.

E. The Licensee acknowledges that it has read this license, including all printed language, that the
Licensee understands it, and agrees to be bound by its terms, and further agrees that it is the
complete and exclusive statement of the agreement between the parties, which supersedes all
proposals, oral or written, and all other communications between the parties relating to the subject
matter of this license.

F. This agreement shall be governed by the laws of the State of Michigan.
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Manual Overview

This manual’s goal is to aid operators/instructors in understanding and utilizing the
FAAC Instructor Operating System (IOS).

First of all note that the IOS is a Microsoft Windows – Compatible software package.

The IOS allows complete control of the FAAC driving simulators. It is used to handle
every aspect of training from simple skill-building and muscle memory exercises to
complex judgment and decision-making traffic conflicts.

The IOS has been optimized to work collaboratively with individual instructor training
needs. It is configurable for ease of use; it can range from being a simple interface to a
feature rich interface.

Each section of the manual is a specific breakdown of the individual components or
functions of the IOS. Specifically this manual will cover the layout of the IOS; the basic
functions and the steps to use the IOS. It features a quick start guide for easy
understanding and a glossary section for additional help.

The manual will also cover the following more complex procedures: the IOS
configurable options, how to use two or more simulators, building a lesson plan and
finally how the IOS and Scenario Toolbox (STB) interface.

Attached at the end of this manual is an appendix explaining optional details or
functions of certain optional versions of the IOS.

Throughout the manual two icons draw attention to important ideas to note:

Tips, Hints and Notes Icon = Ideas for
making better use of the IOS or notes
that contain helpful information related
to the topic being covered

Caution Icon =
Important items you need to be aware of

For Questions Concerning Operations and/or for
Troubleshooting the IOS…

Please Call FAAC Inc. at 1-800-322-2387 and Ask for a trainer

Tips
and

Hints
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Glossary- Definition of Concepts and Terms

There are many concepts and terms that apply to the FAAC software and simulator.
Refer to the following terminology definitions as needed. They are in alphabetical order
for ease of reference.

2-D MAP —
The part of the IOS Session that shows an overhead
view of the visual world while training is taking place.
This map will indicate where vehicles, streets, and
buildings are within the visual world including the current
location of student(s) and other events.

AUTONOMOUS VEHICLE (AVs) —
Computer-controlled intelligent vehicles that navigate within the visual world. Some
IOS’s have the option to use AVs in exercises and free-drive driving. They will respond
appropriately to stop signs and traffic lights. The Instructor can increase and/or
decrease the number of AVs present and how aggressively they drive.

CAB —
The cab is the physical embodiment of the student vehicle as it relates to the exercise. If
the system has an optional Rabbit (See this term further down), it becomes Cab 1, the
first student cab is then Cab 2 and so on.

CLOSED CIRCUIT TV (CCTV) (OPTIONAL) —
It allows the Instructor to view the student while driving to determine whether the correct
physical operations are being performed.

DRIVE BUTTON—
A button represented by a steering wheel icon located on a
loaded exercise form. Clicking this button takes the simulator
from a paused state to a dynamic state.

ENVIRONMENT —
Refers to a number of Environmental Control options, many
related to weather that the instructor can control. Time of day,
fog, rain levels, Wind direction, snowfall, traffic density, and traffic
aggressiveness are examples of options for each simulated
exercise changed by moving the respective bars left or right.
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EVENTS —
One type of event is a Failure, which
occurs at a specific time and place in the
exercise. The other is a Scoring Option,
which enables the scoring graphs and
logs to be setup based on information
from the visual world.

EYEPOINT —
1. The student’s view of the visual world from the driver seat.
2. Also can refer to an IOS function in which controllable objects, such as the Rabbit
and PedPilot, are manipulated. It can be used by the Instructor to fly around the world to
become knowledgeable of the training areas

EXERCISE —
A training situation within a particular visual world. Exercises can be Scripts, IOS
Scenarios, Locations, or a combination of many Scripts/Scenarios (refer to section Left
Panel Breakdown and Exercise Descriptions Pg. 19).

HELICOPTER/ATTACHED MODE (OPTIONAL )—
Enables the Instructor to use the joystick to fly around in the
visual world to witness the student’s driving from a number of
vantage points. This also allows the Instructor to fly around the
simulated world to become knowledgeable about the student’s
training areas.

ATTACHED MODE- allows the Insructor to use the joystick
and view the student vehicle from several angles.

HELP MENU — The Help Menu button on the right side of the Main Menu Bar lists the
version of the IOS system loaded onto the computer.
Click Help  About…..to see the version on the system.

IMAGE GENERATOR (IG) —
A computer that generates graphics for the visual worlds and their objects. Depending
on the number of screens there may be three to nine IG’s per simulator system.

INSTRUCTOR OPERATING SYSTEM (IOS) —
Used to control the simulation training session. The Instructor can customize and
control the number of student drivers involved in a training exercise, weather conditions,
traffic patterns, and more. The IOS consists of hardware and software components.
Hardware includes the desk, computer, keyboard, mouse, video screens, and monitor.
Software configures and carries out sessions that can be either scripted or driven
randomly. It assists in managing and assessing student performance.
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IOS SCENARIO (OPTIONAL)
An exercise that is created from within the IOS. Creating an IOS Scenario allows the
user to choose vehicles and their options, environmental options, events, and routes,
and then save them with a name. This creates standardization within your training
program (running the same scenario for every student for a particular learning task).

JUMP BACK BUTTON-
A button similar to rewind on a VCR/DVD located on a loaded exercise
form. The Instructor can jump back to an earlier mark (previous point on
the exercise time span) during any time during training. An example of
when this is used is after a student crashes his/her vehicle. From the
accident scene, the exercise can be jumped back 30 seconds in time,
either to review that drive/crash for observation, or to redo that drive
after receiving Instructor input. Jump Back can also be used to simply
scroll through the marks until the desired one is reached.

KEYPAD (OPTIONAL)
A membrane panel device that controls the session, similar to the IOS. The Keypad
resides at the back or side of the student vehicle. It may be used by the Instructor while
standing next to or in back of the student while giving the student direction.

LESSON PLAN —
A sequence of exercises created to ease curriculum management and speed the
transition from one exercise to the next. A lesson plan strings multiple exercises
together to create a sequential training curriculum based on a particular training
objective. Trainees progressing more quickly from exercise to exercise allows for less
intervention from the Instructor.

LOCATION—
An X, Y, Z and Direction coordinate in the visual world.

MASTER VEHICLE —
The primary student vehicle being used in a simulation exercise.
The master vehicle concept is important in Linked Exercises.
When more than one student is driving in the same training
exercise (i.e., when using a Linked Exercise), one simulated
vehicle must be designated as the Master Vehicle. Computer-
controlled traffic (autonomous vehicles) will be most dense in the
area immediately surrounding the Master Vehicle.

OVERHEAD —
A mode or view that enables the Instructor and the student to see the student vehicle
from above. The overhead view allows the Instructor and student to view how close the
vehicle is to other objects. This mode/view may be accessed from the IOS or a
switch/button on some vehicle dashboards. (Optionally it can also be accessed by the
remote keypad)
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PATHDRIVER—(OPTIONAL)
A method to develop driving routes for the student vehicle and scripted vehicles done by
driving the route and saving them accordingly. These can then be imported into the
Scenario Tool Box (STB) program to create a Scripted Scenario (AKA Script).

PEDPILOT — (OPTIONAL)
1. A PedPilot is a joystick. It is used to observe the student driver’s vehicle. If attached,
the joystick is tied to the student vehicle and allows viewing the student vehicle from
different angles.
2. It is also used with a virtual pedestrian to control the pedestrian movement during the
exercise. When a pedestrian is dropped into the session, moving the joystick makes
them walk, run, or jump.
3. If in helicopter mode, the joystick is free to maneuver the view anywhere in the visual
world.

RABBIT (DESKTOP) — (OPTIONAL)
An optional component which when attached is simply called, “the Desktop”. The Rabbit
desktop can be used as an instructor-driven vehicle during a training session. The
Rabbit comprises a table next to the IOS with a steering wheel, ignition switch, blinkers,
accelerator, brake, and video screen. The Rabbit is NOT designed to handle like the
student cab (simulator).

REDRIVE-
It is the act of a trainee getting a second chance at driving a portion of an exercise that
he/she had unsuccessfully driven earlier. Once the Instructor has jumped back in the
exercise using the Jump Back button he or she can click the Drive Button on IOS (or
optional keypad) and drive the portion of the exercise he/she wants to redo or study.

REPEATER SCREEN (OPTIONAL)
A screen on the IOS desk or wall that allows the Instructor to view the front screen of
the simulator.

REPLAY —
Allows the Instructor and student to view the student’s
performance. Anytime during an exercise an instructor may
pause the exercise and jump back to a prior mark. When the
instructor reaches a desired mark, the Replay button is then
selected. The instructor and student then will be shown the
driver’s previous driving session. The Instructor may pause and
resume the drive at anytime. In addition, the Instructor has the
ability to increase or decrease the speed of the Replay.

* Replay only replays up to the last 10 minutes of an exercise.
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SCRIPTED SCENARIO (AKA “SCRIPTS”)—
An exercise that is created with the FAAC Scenario Toolbox™ (STB) software. Scripted
driving exercises are stored as files on the IOS computer. They have names ending in
.STB (for Scenario Toolbox). Once a script is loaded on the IOS, additional options are
NOT recommended to be set from the IOS. There are many configurable options that
can be set in a script. Speed limits, stop light controls, accident setups, Scripted
Vehicles (SV) and pedestrian controls, are some of the variables that can be set in the
STB. Once they are set up they will repeat their actions the same way every time they
are run.

SCRIPTED VEHICLE (SVs) —
Scripted Vehicles are used in the Scenario Toolbox to set up traffic and traffic conflicts.
Scripted Vehicles can be cars, trucks, buses, pedestrians, animals, bouncing balls, etc.

SPEED BAR -
A slider panel on the front of an exercise form that
allows the instructor to move quickly to a point within
the exercise. It allows for Fast Rewind, Slow Motion
and Fast Forward.

STARTING LOCATION (OPTIONAL)—
An x, y, z, direction location within one of the visual worlds. The location is expressed
as a coordinate, typically shown as a number of feet East/West and a number of feet
North/South. An example would be 1000 feet East and 1500 feet North. These
locations are used to determine where, within the visual world, the student will begin
training. The Instructor may create new starting locations and give them names and
descriptions. Each visual world will have its own unique starting locations.

STUDENT TRAINING STATION (STS) —

1. This consists of the physical student cab(s), the motion system (if there is one),
VDUs, electronics rack, IGs, and equalizer. Each student cab and accompanying
computers is an STS. Meaning there may be an STS1, STS2, STS3, etc.

2. The name “STS computer” has also refered directly to the LINUX computer that is
part of this station. Another name for the STS computer is the APP1, APP2, APP3.

STUDENT VEHICLE (Ownship) —
The vehicle driven by the trainee/student in the simulation. Unlike an Autonomous
Vehicle, the computer does NOT control a student vehicle, the student controls the
vehicle. The Instructor chooses the vehicle the student drives from a list of available
Student Vehicles (popular examples include buses, fire trucks, police cars, sedans, and
more).

VISUAL DISPLAY UNIT (VDU) —
Visual Display Units or screens. The three or more screens make the viewing part of the
Cab. They provide approximately a 225 viewing area that simulates having normal site
lines for the driver. Three to eight VDU’s possible in a system.
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VISUAL WORLD —
Consists of all the images displayed on the simulator(s). It contains buildings, streets,
parking lots, hospitals, etc… simulating everything that the real world contains.
Typically, there many different visual worlds to choose from to match any training task
desired.

Abbreviated Terms

AAR—(OPTIONAL)
After Action Review. Replay with PIP (Picture In Picture) active. Once the simulator
goes into Replay mode, Redrive is NOT an option.

MDC—(OPTIONAL)
Message Display Computer. This is the computer in the student’s vehicle which
receives text messages from the IOS, simulating a dispatch and optionally has a map of
the visual world.

MICK (OPTIONAL)
Micro Instructor Control Keypad. It’s like the Keypad mentioned previously in the
glossary but smaller and wireless. It has fewer selections (no Failures or Weather
Selections). It has selections for running Lesson Plans, Push to Talk (PTT), Cab
selection and keys for replay, drive, stop, pause and jump back

PIP—(OPTIONAL)
Picture in Picture. This is used with a student and After Action Review. The student can
see themselves driving in the center VDU while replaying a previous driving sequence.

PTT—(OPTIONAL)
Push to Talk. Some versions of the IOS control the student driver’s radio. The
instructor can select this in the IOS to talk to the student.
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Quick Start the Instructor Operator Station (IOS)

STARTING THE IOS-

To begin running the IOS, locate and double click the “IOS Icon” on the left side of the
Windows Screen.

Figure 1- The IOS Icon on the Desktop
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LOGGING IN (OPTIONAL STEP)-

 IF Login HAS been enabled, the Login Form will pop up

 IF Login has NOT been enabled, the IOS Workspace Window will pop up directly

Figure 2- The Login Form

The Login form is a configurable aspect of the IOS. If the login form appears, the user may
have to input a valid User ID and Password and then select the “Login” button.

If you have not been provided a valid Login, left click the “Login as Default” button to start
the IOS in a lower privileged mode.

To Logout, select the Menu ->Options-> Logout to end the session of the current Instructor
at anytime.
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THE IOS WORKSPACE WINDOW-

The IOS Workspace Window pops up automatically if Login has NOT been enabled.

Figure 3- The IOS Workspace WindowOptional
Buttons
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INSTRUCTOR OPERATOR SYSTEM (IOS) DESKTOP-

The Instructor Operator Station workbench (shown below in Figure 4) will look and
operate similar to other programs based on the Windows® operating system.

There are Windows typical menu names at the top of the screen. Left clicking the
menus allows control of training conditions such as lesson plans and/or scenario
creation, student management, and past scoring records.

The DEFAULT IOS Workspace Window menu consists of ONLY the File, Edit, View,
Option, and Help menus. (Additional Menus appear if the trainer is logged in as
Administrator or as Instructor.)

Figure 4 - Close up of IOS Menus in Upper Left Corner of Workspace Window
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UNDERSTANDING THE LEFT PANEL OF IOS WORKSPACE WINDOW-

On the left of the IOS Workspace Window are the main training Exercise headings laid
out in a vertical list. These headings correspond to the types of training selections
available and each heading has additional sub-selections/exercises available. These
expanded sets of sub-selections/exercises can be accessed by simply clicking on the
plus (+) signs on the menu located directly to the left of each heading/training type.

Each type of training (Scripted Scenarios and Lesson Plans) has its own bolded
heading as shown below in Figure 5.

Figure 5- Left Panel Selections

Customers often select different IOS training types to fit their training needs. The
window pictured above is a typical example of a set of IOS training selections, but note
that yours may be different.

Plus Signs
expand the

lists of
Exercises

Refresh button
updates the lists with

any new additions

Optional
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STARTING A TRAINING EXERCISE-

 To start an Exercise from any of the selections simply left click and drag the desired
Exercise with the mouse and drop it into the dark gray workspace area.

 An alternative method to starting an Exercise is to double click on the Exercise heading
itself.

Figure 6- Showing How to Select an Exercise
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STARTING A TRAINING EXERCISE (CONTINUED)-

If the Exercise is available, the Exercise Form will pop up on the right hand side of the
IOS Workspace Window. Figure 7 below shows the typical view of an Exercise Form
with its many variable option icons displayed.

Note that the Exercise is NOT running until you left click the “Load
Exercise” button.

In SOME versions of the IOS, a textbox (highlighted in green in the figure below) will
appear at the
bottom of the
IOS window.
This textbox
simply gives a
snapshot of the
exercise
description.

Figure 7 DOES
include this
textbox option
however, yours
may NOT.

Figure 7- Exercise Form loaded on IOS Workspace Window
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RUN AN EXERCISE-

To run an Exercise on the IOS simply press the “Load Exercise” button on the Exercise
Form.

Figure 8- Pressing the Load Exercise button

Note that if the simulator is configured to “Pause on Start,”
then the Drive button will need to be left clicked to start the
Exercise.

If the simulator is NOT configured to “Pause to Start,”
then the Exercise will start automatically with the Load Button.
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STOPPING AND PAUSING AN EXERCISE-

Pressing the “Stop” button on the Exercise Form window. acts as the “Pause” button
when the instructor wants to pause the exercise at any time. Once paused, the
Instructor can use the other icons on the form to jump back, replay, redrive, or run an
After Action Review (AAR, not available on all IOS systems).

Figure 9 – The Stop/Pause button
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EXIT AN EXERCISE-

To exit from an Exercise at any time, left click on the Exit button or on the Red X in the
upper right hand corner of the exercise. Some systems will be configured to bring up a
scoring sheet when the Exit button is pressed.

Figure 10- Exiting an Exercise

EXIT THE IOS COMPLETELY-

 To exit the entire IOS program, use the File ->Exit method by clicking on File in the
upper right hand corner of the IOS Workspace Window and then selecting Exit from the
drop down menu.

 Or simply click on the Red X in the upper right hand corner of the IOS Workspace
Window.

Figure 11- Exiting the IOS Program

End of Quick Start
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Remember to expand the
training selections to reveal

their sub-selections/exercises,
left click on the plus (+) signs

next to their headings!

Figure 12- Left panel of IOS
Workspace Window showing
one IOS version with many
types of training selections

Left Panel Breakdown and Exercise Descriptions
Once the IOS Icon on the desktop has been selected, the training selections available
are listed vertically on the Left Panel of the IOS Workspace Window.

There are two types of IOS Workspace Window Left Panels that may come up
depending on the version of IOS you have. See appendix if you see Figure 12 as your
Left Panel.

The main difference between the two panels is the panel in Figure 13 is set up for
training straight from Scripts. These training exercises are repeatable for every student
driver. There are no additional options for Locations or IOS Scenarios as shown in
Figure 12.

Figure 13- Left Panel of IOS

Workspace
Window
showing an
IOS version
with a
simplified set of
training
selections
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TYPES OF TRAINING EXERCISES-

There are several ways to train using the IOS. An instructor, based on their desired
curriculum, may decide to train using a Scripted Scenario or a Lesson Plan or in any
combinations. (SOME versions of the IOS also include IOS Scenarios and Starting
Locations as additional training choices. See Appendix if your IOS has these additional
two options.)

Scenario Toolbox Scripts or Scripted Scenarios (Scripts) are pre-built driving routes
designed with specific training purposes. Scripts can be built using the Scenario
Toolbox by Instructors. They can be short, medium, or long. Scripts focus on conflicts
and interactions with programmed pedestrians and vehicles. An example of a Scripted
Scenario (Script) would be a police pursuit training exercise.

A Lesson Plan is a grouped series of Script Scenarios (and possibly IOS Scenarios if
applicable) that focus on a specific training objective. For example, a Lesson Plan
focusing on avoiding head-on collisions may include Scripts that focus on driving in fog
or rain and ones that simulate Events like flat tires that may lead to a head-on collision
in real life.

-The Instructor groups Scripts in a Lesson Plan that he or she deems appropriate
for their desired curriculum.

-Lesson Plans can be repeated for each student, ensuring accountability

Note the different Visual Worlds are useful for training for specific
environments. These include urban, country, expressway, small town,
and mountain driving. Depending on the configuration of your IOS
system, there may be fire stations, police stations, hospitals, and many
other places that can be used for any commercial driver training.
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IOS Program Menus
Below is the most common list of the menus available on an IOS. Based on need, not
all simulators have the same menu selections. Detailed descriptions of the menu
selections are on the next few pages.

File

 Open Script

 Import Script

 Exit

Edit

 New Scenario (Optional)

 Lesson Plan

View

 Past Scoring Records

 Simulator Layout

 Status Bar

 Left Panel

Students

 Manage Roster

Instructors

 Manage Instructors

Options

 Refresh IGs

 Sim Volume level

 Change Admin Password

 Logout

Help

 About
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Figure 14- All IOS Program Menus

File:
Scripts are created in the Scenario Toolbox. When imported on the IOS, the Scripts are
placed in the correct IOS directory.

Open Script
Select this option and it opens a file directory where a Script can be
selected from anywhere (the desktop, a memory stick etc.) Further this
option allows for testing a Script to ensure it works properly before placing
it in the IOS directory

Import Script
Select this option to place Scripts into the correct folder in the IOS
directory.

Exit
Select this option to exit out of the IOS program. The IOS program can
also be exited by left clicking on the Red X in the upper right hand corner
of the IOS.

Edit:

New Scenarios (optional)
These may or may NOT exist on your system. If “Scenarios” are on your
IOS then select to bring up the form to build a New Scenario.

Lesson Plan
If selected, the Lesson Plan form appears and then Scripts and/or the
optional IOS Scenarios can be selected and grouped under that Lesson
Plan.

View:

Past Scoring Records
A form that shows the instructor previous exercise scores per student.
Past Scoring Records only show students that have been entered into the
IOS and named in the Exercise.
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Simulator Layout
If checked is an additional window pops up that can be used as a cue for
student cab placement.

Status Bar
If checked will show the Status Bar at the bottom of the IOS. The Status
Bar shows the Instructor’s name, date, time, student vehicle name and the
student name (if student is selected).

Left Panel
If checked, the Left Panel of the IOS Workspace Window is revealed.
If unchecked, the Left Panel will disappear. This is a good option if the
instructor needs extra space on the IOS Screen.

Students: (Optional Window)

Manage Roster
If selected, a form appears. The students’ names, rank, and class can be
entered or chosen. Manage Roster also offers the ability to list all the
students with their pertinent information and will allow the instructor to
delete students as well. Through the Manage Roster the Student
Database can be saved or backed up.

Sort Students
This allows the students to be sorted by first or last name, or by class.
Sorting is the ONLY function this selection can perform.

Instructors: (Optional Window)

Manage Instructors
If selected, a form appears and allows an Instructor or Administrator to
add new or delete Instructors.

Options:

Sim Volume Level (Optional)
The Sim Volume Level allows the Instructor to control the sound on each
student cab or vehicle. It also controls road and vehicle sounds etc.

Refresh IGs
When selected, this will send a signal to the Image Generators (IGs) to
update their image.

Change Admin Password
This allows the user to change the admin password.

Logout
When selected, it will log the user out of the IOS program.

Help:

About

This allows the Instructor see the software version number of the IOS
program.
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Figure 16- Exercise Form with Advanced Options Highlighted
(Some are grayed out because Exercise is NOT running)

Exercise Form Icon/Button Breakdown

LOAD EXERCISE-

 Choose the type of training exercise you would like to practice from the Left Panel on
the IOS Workspace Window. Then click and drag the desired exercise with the mouse
and drop it into the dark gray workspace area. Click the “Load Exercise” button to
start/run the exercise. (Refer to the Quick Start Guide at the beginning of the manual.)

Note: If “Pause to Start” is configured on your system, then you must also
press the Drive button to finally start the exercise.

Figure 15 – The Load Exercise button

ADVANCED OPTIONS-

 In the lower portion of the Exercise Form is a row of Advanced Options. These are
visible at all times on the Exercise Form, however some Options/Icons may be grayed
out (signifying they are NOT available) when the actual exercise is NOT running.
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Advanced Options Include:

 Traffic Failures/Events

 Change Environment

 Exercise Description

 Real-Time Scoring

 Overhead View

 Exercise, Visual 2D Map

Figure 17 – Advanced Option Panel with Icons labeled

Note that these are the basic buttons; your Exercise Form may have
more!

Overhead
View

Change
Environment

Real-Time

Scoring

View Exercise Map

View Exercise
Descriptions

Failures/Events
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EXERCISE PLAYER CONROLS-

 Once the “Load Exercise” button is clicked, the panel where the “Load Exercise” button
was will be replaced by the Exercise’s Player Control icons/buttons as shown below.

Figure 18- Exercise Form BEFORE
“load Exercise” button pressed

Figure 19 –Exercise Form AFTER “Load
button” has been pressed revealing

Player Controls

 The IOS Exercise Player Controls are as follows (going from right to left on the Panel):

Exit Button (Exit Icon)

At far right of the Player Control panel is the Exit button. It first will stop the
Exercise and then it closes the Exercise Form so that a completely
different Exercise may be started.

Stop Button (Square Icon)

It acts as the Pause button, stopping the Exercise temporarily as desired.

Replay Button (Circling Arrows Icon)

It replays a student’s driving path from a requested previous point. Also if
PIP (Picture In Picture) is enabled, the Replay button acts as the After
Action Review (AAR) button (See Glossary Pg. 8) where it will replay the
student’s driving path with an in-screen camera view. (* Only replays the
last 10 minutes of the exercise.)

JB-Jump Back Button (VCR/DVD Rewind Icon)

This allows an Instructor to “jump back ” or go backwards to a previous
time mark in a student’s exercise.
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Drive Button (Steering Icon)

This button when pressed allows the student to Redrive a desired portion
of an Exercise. This is used only after the Jump Back button is pressed.

 Replay Versus Redrive-

Redriving (which is the act of “Stopping” in an Exercise, “Jumping Back” and then
pressing the Drive button) gives the student the ability to actually redo a portion of
the Exercise they are working in. Replay (the act of “Stopping” an exercise
“Jumping Back” and pressing the Replay button) simply plays through the portion the
student just performed exactly how they drove it (like watching a movie).

Note that when stopped and in Replay, the Instructor can switch into
Overhead view mode for a different perspective on the student driver’s
position in the Exercise

 Jump Back, Redrive, Replay and the optional AAR (see next page) allow the instructor
to return the student to an earlier time in the training exercise. The instructor can
mediate driving situations (pedestrian intersections, moments of decision) for the
student. This allows the student to learn the correct course of action and in turn,
practice the appropriate driving techniques.

 Review Mode-

Once the “Load Exercise” Button is pressed, the Exercise loads and runs. When the
instructor has decided to stop the student exercise, Review mode may be entered.
Review mode begins when the “Stop” button is pressed. The “Stop” button can act as a
Pause button.
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OTHER IMPORTANT PARTS OF EXERCISE FORM-

 Top Info Panel of the Exercise Form-

The Top Info Panel is located directly above the Player Control Panel on the
Exercise Form. This panel gives basic information about the Exercise being
used. It shows the name of the Script, and the amount and types of vehicles in
the Exercise including a picture/icon of the vehicle(s) and optionally the PIP and
PTT features/buttons.

For example, in Figure 20 below the name of the script is animated_ped.stb and
the Exercise contains one vehicle on Simulator/Station #1, a Crown Victoria (the
M denotes the vehicle is the Master Vehicle); PIP has been checked and PTT is
disabled.

Figure 20 – An Example of an Exercise Form with its Top Info Panel Enlarged

The simulator also has optional capability of filming the driver. After Action Review
(AAR) allows the user to watch this “film.” When AAR is run, the student and the
Instructor can review the Exercise with a replay of the student driver embedded in
the center screen. The driver will see themselves driving through the Exercise using
Picture in Picture (PIP) if the PIP box is checked in the Top Info Panel of the
Exercise Form as shown above in Figure 20. (Replay only replays the last 10
minutes of an exercise.)

Note that once the Replay button has been played as AAR the student can
NOT Redrive in an Exercise.
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 Two or More Vehicle Icons (representing a Linked Exercises)-

Scripts can be built with multiple student vehicles. If two or more student vehicles
exist in an Exercise it is called a Linked or Networked Exercise and a picture/icon of
EACH vehicle would appear in the Top Info Panel on the Exercise Form as shown in
Figure 21 below.

ALL the vehicle icons NEED to be represented in the Top Info Panel in
order to participate in the Exercise. The vehicle icons signify they are
ready to participate in the Exercise, so ensure each are present BEFORE
pressing the “Load Exercise” button and beginning training.

Figure 21 – An example of a two vehicle Linked Exercise

 Status Bar On Exercise Form-

The Status Bar is located directly above the Top Info Panel on the Exercise Form
very near the top of the form. The most important information it keeps is the
Exercise’s running time shown as a clock counter in the Status Bar. In Figure 22 the
counter shows 0:17 which means this Exercise has been running for 17 seconds.

Figure 22 – Status Bar on Exercise Form
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Slow
MotionFast

Rewind

Fast
Forward

 Speed Bar On Exercise Form-

If an Instructor wishes to have finer control of the Exercise’s timeline (perhaps to
perform a Repay or Redrive), the Speed Bar can be used . The slider (shown in
Figure 23) allows the instructor to Fast Rewind, Slow Motion, Regular Replay or Fast
forward to any point in the Exercise’s timeline.

Figure 23 – Speed Bar on Exercise Form

Click and hold down on the slide bar button to move through the Exercise’s time as
desired. Moving the bar to the right will move you forward in time, either in slow
motion or regular speed. Moving the bar to the left will rewind the Exercise back in
time. Once you find the point in the Exercise’s time you need simply stop holding the
mouse button (let go).
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Basic Exercise Operation Options

STATION OPTIONS-

 When opened, the Station Options Window allows the user to perform the following:

 Assigning a vehicle,

 Assigning a student,

 Saving a location,

 Vehicle options,

 Failures,

 Advanced,

 Set As Master.

 Assign Drunk Level (Optional)

 Some IOS versions have Save Location (See Appendix).

 To access the Station Options, right click on the vehicle picture/icon that you want to
change

Figure 24- Station Option Window
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Assigning Vehicle

In the Station Options Window, to assign a new vehicle to the Student Training
Station (STS), left click on the “Assign Vehicle” option and select a new vehicle
from the drop down list.

There are many types of vehicles available and they vary between
systems. In Figure 25 below only four vehicle options are available.
Your list of choices however, may be different.

The “Assigning Vehicle” option is ONLY available BEFORE the
“Load button” has been pressed

Figure 25 – Selecting a Student Vehicle Type
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Assigning Student (Optional)

Also in the Station Options Window, the “Assign Student” option will allow a
student to be associated with a selected vehicle.

This option will bring up the Student Selection Form, shown below in Figure 26.
A Class list provides the opportunity to selectively find students based on their
Class (see Real-Time Scoring section).

Figure 26 – Student Selection Form

Simply select the Class of the students you want to find by using the drop
down arrow next to the Class textbox. The student list will then contain
ONLY the students who are in that selected Class.

Select the “Update” button to update the student list. Once you have
entered you update(s), click the “OK” button to save.

Once a student is assigned, that student will be assigned to the simulator
until the IOS is CLOSED. Any Scoring Data scored for the simulator will
be credited toward that student. A different student may be assigned at
any time.
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Advanced

Advanced options are additional specific vehicle options that the Instructor can
configure. Advanced Options are NOT available for all IOS versions and may
appear completely different on each system and for each vehicle.
If available, once selected the Set Vehicle Screen will pop up as shown in
Figure 28 below. This screen is where the unique-to-each vehicle options will
be listed.

Figure 28 below shows an example of when the vehicle is a Truck and the
Advanced option allows the selection of the truck’s transmission and trailer
type.

Figure 27- Selecting the Advanced
option in the Station Options window

Figure 28 - An example of a Set
Vehicle Screen for a truck.
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Set a Master

The “Set As Master” menu option is available in a Linked Exercise (more than
one student driver in one exercise) and gives the Master Vehicle ability to
change in an Exercise. If the Rabbit vehicle is part of the exercise, it too can be
chosen as the Master (See Appendix).

Figure 29 – “Set As Master” option in the Station Options Window

The “Set As Master” option is ONLY available if the exercise is NOT
running and a Master Vehicle has NOT already been selected.

The Master Vehicle will attract most of the AVs in the Visual World.
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VEHICLE OPTIONS (A Sub-Menu of Station Options)-

 Clicking on Vehicle Options in the Station Options Window brings up a sub menu of
selections for different vehicle functions. Once the Vehicle Option menu is revealed,
simply left click on the desired function to select. A check mark will appear to signify the
function is turned ON. Vehicle Options may vary on each IOS system. For example in
Figure 30 below, the selections are only: ABS (brakes), PIT, Wing Visuals, Compass,
Snow Chains.

Figure 30–One example of a Vehicle Options Menu from the Station Options Window

PIT (Pursuit Intervention Technique)
It is used by law enforcement units to nudge a car off the road.

Compass (AKA Digital Onscreen Display)
It shows the speed, state of lights, siren and radio and the direction of the
user’s vehicle. Some displays show only direction.

Figure 31 – Compass / Digital Onscreen Display

Speed Direction
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The Toggle Menu is in particularly beneficial to
an Instructor for LINKED Exercises (multiple

student vehicles) because it saves time in
allowing the Instructor to configure all the

student vehicles simultaneously

EXERCISE TOGGLE FUNCTIONS-

 Toggle Button

A small button near the top of the Exercise Form shown in Figure 32 below.
Right click on the button to reveal a small menu of Toggle function choices. They
enable the Instructor to control variables on a student vehicle(s). These include
the Compass, ABS, and PIT.

Figure 32 – Toggle Menu pulled up on Exercise Form

IF A SINGLE VEHICLE requires a change, like turning on PIT for example,
first right click on the appropriate student’s vehicle picture/icon on the Exercise
Form and then Toggle the variable you want to change.

The “Toggle All Compass” option is ONLY available while an Exercise
is running.
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Advanced Options Details and Operation

ADVANCED OPTION BUTTONS-

Figure 33- Advanced Options Panel on Exercise Form

Failures/ Events Button-

It represents Instructor-controlled operations and when clicked on pulls up a form
with four tabs including: Traffic Maneuvers, Vehicle Failures, IOS Events and
Script Events shown in Figure 34 below.

Figure 34 – Failure/ Events Form

The options that appear under each Tab are system-specific.
However, FAAC representatives are available to re-configure what
options lie under each tab.

By simply clicking the desired button of any of these maneuvers, failures, and
events, it is triggered in real time (almost immediately) and effects the student
vehicle wherever it is located

In some cases, the button gives a description of its functionality. These
descriptions appear as a short line of text to the bottom right of the form when the
mouse arrow hovers over the button.
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Change Environment Button-

To change the environmental settings in an Exercise, left click on the Sun Icon.
The window shown in Figure 35 will pop up. The changeable environmental
conditions are Weather (including Night, Fog, Rain, Snow and Dust), Traffic
Aggressiveness and Density, a Vehicle’s Traction and Weight and Wind
Magnitude.

Figure 35 – Environment Form

To adjust each condition in the Environment Form, click and hold down on the
respective slider button with the mouse, and move the slider left or right. Moving
the slider left will create less of the desired condition (e.g., fog or rain), whereas
moving the slider right will create more of the condition. For example, to simulate
a time of day closer to nighttime, move the “Night” slider to the right, or to insert
more fog, move the “Fog” slider right. Any adjustments to any slider will show its
effects in the Exercise immediately.

Note that the circular Wind Direction button is operated differently.
With this button, simply click on the direction you want the wind to
blow in the Exercise (North, East, South, West).

The IOS only allows SOME of the simulators to use a “Weight” slider
to increase or decrease the weight of a student vehicle.
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The Exercise Description window is
printable using the Print button on the

lower left side of the description window.

View Exercise Descriptions

Click the Page icon and a detailed description of the current exercise being
utilized pops up in a window shown below in Figure 36. The information on the
window was entered at the time the Script or IOS Scenario was developed.

Figure 36 – An example of an Exercise Description Window

Typical content for an Exercise Description window includes: the route a driver
should take, obstacles that may be encountered, duration of the Exercise,
training cues, and training objectives that the Script teaches.

The Exercise Description window is resizable to improve viewing. Those
dimensions chosen initially will be recalled next time the window is opened.
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Real-Time Scoring Button-

Click the Bar Graph Icon to bring up the Real-Time Scoring Form shown below in
Figure 37. This form graphically shows several key scoring categories as the
student vehicle(s) drives through the current exercise such as: distance, Speed,
Brake Threshold, Minor Collision and more.

Figure 37 – An example of a Real-Time Scoring Form

In addition to simply viewing the Form/graphs, the Instructor may set pre-
programmed alarm limits that cause the graphs to change colors when they are
violated.

If there are more than one student vehicle participating in an Exercise then each
has their own Real-Time Scoring Form, complete with individual graphs and
Scoring Notifications (see next page).
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 In the lower LEFT corner of the Real-Time Scoring Form is a boxed panel (as
shown in Figure 38) that shows additional variables such as lights, sirens and
radio that can be monitored.

Figure 38 – Close up of bottom right corner panel on Real-Time Scoring Form

Note that it is possible to have more than one major collision show up in
the Major Collision graph on the Real-Time Scoring Form.

Also collisions can still accumulate while in Redrive and/or in Replay.
Any collisions that do occur during Replay and/or Redrive will register
on the Major Collisions graph after Replay and/or Redrive is concluded.
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 In the lower RIGHT corner of the Real-Time Scoring Form is the panel labeled
Scoring Notifications (shown below in Figure 39). This panel logs driving
violations as they occur. It logs the time and description of each violation as well
as any Event/Failures that occur.

Figure 39 - Scoring Notifications Panel on Real-Time Scoring Form

The Instructor can choose which notifications are displayed by clicking the
options (Scoring, Events, Both) below the notifications list window. See them at
the bottom of Figure 39. By selecting “Scoring” only scoring occurrences such as
stop signs and and/or light signal violations will be logged. Select “Events” and
only Events will be logged like tire blowouts or engine failures. “Both” logs all.

If there is more than one student participating in an Exercise, the “Cab” tabs take
you from one student vehicle’s Scoring Notification Panel to another.

 ADDITIONAL INFORMATION concerning Real-Time Scoring including Organizing
Real-Time Scoring Graphs and Saving and Loading Scoring Configurations is available
in the section Real-Time Scoring Graphs Details on Pg. 58.

Overhead View Button-

Clicking on the Magnifying Glass Icon will allow the simulator(s) to enter an
overhead view mode. The Instructor and the student(s) can access up to six
different views of their current Visual World.

This feature is especially useful during while using Replay, Redrive and/or for the
Instructor to observe the student vehicle’s position relative to other objects in the
Visual World.



43

Map Button

Clicking the Map button on the Exercise Form will bring up a 2D map of the
Visual World in which the Exercise is taking place, as shown in Figure 40.

On the 2D
map, the
red circle
is the
student
driver
vehicle’s
location. It
moves with
the student
driver’s
vehicle so
an
accurate
depiction
of his or
her exact
location in
the Visual
World is
always
accessible.

The yellow portion within the circle indicates the direction of the student vehicle.

The green circles are Autonomous Vehicles, scripted vehicles or pedestrians.

Figure 40 – An example of the 2D map pulled up by selecting the Map
Button
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Figure 41 – Close Up of bottom panel of 2D Map.

Zoom-
Use the plus and minus buttons under the “Zoom” icon to enlarge and/or reduce
the 2-D map view. The number in between the buttons indicates the current level
of zoom.

The “Lock” Option-
This option is located on the bottom panel of the 2-D map. If a certain vehicle is
selected versus “None,” it will ensure the 2-D map will automatically remain
centered on the Master student’s vehicle.
If the “Lock” option is set for “None” then the viewer can view any portion of the
map.

AVs box-
A checkmark in the “View AVs” box will cause the Autonomous Vehicles (AVs)
present in the exercise to appear on the 2-D map signified by the green circles
on the 2D map as mentioned earlier.

Use Locator Box (IOS Version specific)- See appendix
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Event Triggers on the Map-
An “Event” is a Failure that can be triggered to happen to a student vehicle such as a
flat tire or brake failure. They will occur when the student vehicle drives through a blue
circle on the 2D Map. These blue circles can NOT be seen by the students, but appear
on the 2D Map as shown below in Figure 42.

Figure 42 – 2D Map Showing Possible Events or Failures in Blue circles

Note that Events/Failures are simulator-specific.
Not all simulators have all Events/Failures.

To create an Event, place the cursor on the 2-D Map where you want the Event
to occur, right-click and insert a “Drop Event Trigger.” It will pop up on the 2D
Map as a blue circle. “Event Triggers” will initiate region-specific events planned
by the Instructor (brake or temperature failures, etc.)

The Event Trigger pops up small and may be just off the road. The circle can be
moved and enlarged by using the left mouse button at anytime
To move, place the mouse cursor in the center of the blue circle then left-click it
and drag the circle to the desired location.

Note that once Events are dropped into the 2D map, they occur
spontaneously. They are NOT saved anywhere else and are NOT
repeatable once the Exercise is closed.
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OTHER ADVANCED OPTIONS (OPTIONAL)-

There are MORE optional Advanced Options available ONLY upon a customer’s
request. They include the Cab Override Button (signified by a Lightening Bolt Icon),
Gate Access button (Light Switch Icon) and the IOS Override button. If requested the
desired button(s) will appear on the same Advanced Option Panel as the standard
buttons as seen in Figure 33- Advanced Options Panel on Exercise Form on Pg.38

These optional buttons/Icons are NOT pictured in Figure 33- Advanced
Options Panel on Exercise Form on Pg.37

Cab Override button

This allows the Instructor to override any cab controls and interact with the
student vehicle directly. Also the Instructor can clear a Failure if the student
does correct the action.

Gate Access button

This allows an Instructor to open gates or raise or lower railroad crossing bars
spontaneously.

IOS Override

This allows the Instructor to turn OFF or reset Instructor Operations
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Radio Communications (Optional)-
Radio Communications allows the Instructor to talk directly to each student cab. If there
is Radio Communication as part of the simulator, there are three ways it can be
accomplished.

1. Push to Talk

There is the “Push To Talk” (PTT button) on the Exercise Form and the “Push
To Talk All” (PTT ALL button) on the bottom of the Left Panel on the IOS
Workspace window as shown in Figure 43 below.

The PTT button allows the Instructor to talk to ALL student cabs participating in
ONE Exercise (called a Linked Exercise), while the PTT ALL button allows the
Instructor to talk to ALL the student cabs in ALL the current running Exercises.

Figure 43 – The PTT and PTT ALL Buttons for Radio Communications

The Instructor must press the PTT ALL or the PTT button for the student
to hear the Instructor. In turn, the student has to press the button on his
microphone to speak back to the Instructor. If there is more than one
student in an Exercise ALL the students and the instructor can hear each
other with PTT ALL.

2. Mumble

A program that may be on the IOS and simulator. It is a Voice Over IP
VOIP application that uses headphones with microphones built in.

Press for
student(s)

to hear and
speak

Press for
Instructor to

be heard and
speak
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3. Two Way Radios
Real radios that both the instructor and student(s) use.
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Creating and Using Scripts

CUSTOM SCRIPS-

 Custom Scripts can be created to meet specific training objectives, re-create
problematic situations, or address specific training issues. Scripts allow the instructor to
set up many types of traffic situations. Scripts are especially beneficial for when multiple
students need to be trained identically with an Exercise or if a specific Exercise needs to
be repeatedly practiced with a specific traffic layout.

 Customized and repeatable training Scripts can be created to use with the simulator(s)
if Scenario Toolbox (STB) is on the IOS system. FAAC may also deliver the IOS with
pre-built Scripts and/or deliver more Scripts after installing the system.

Within the IOS, Scripts appear in the Left Panel of the IOS Workspace Window (see the
section Understanding The Left Panel on Pg. 18). A close up of a list of Scripts in
the IOS Workspace Window is shown in Figure 44 below. Also to start a Script, see the
Quick Start Guide section Pg. 8.

Figure 44 – An Example of a list of Scripts

 Time can be saved by setting up preferences for vehicle types, weather conditions,
starting locations, traffic density, number of drivers, and more. The end result would be
a Script with all those chosen conditions making those desired conditions easily
accessible with one or two mouse clicks.
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FILE MENU COMMANDS AND SCRIPTS-

 Scripts have a Script file name ending in .stb and should be copied into the IOS
program directory. There are a number of ways this is accomplished.

1. The easiest way to place a Script into the IOS is go to the File menu and
select “Import Script”. Then select the desired Script from the “Select
Destination for Script Import” option, and finally left click on the “Import”
button.

2. If a Script was developed in STB on the IOS computer and is saved in the
IOS Script files folder (the default place to save), it automatically appears in
the IOS Workspace Window under the “Scripted Scenarios” heading on the
Left Panel.

3. If a Script was developed on another computer, save a copy of the file onto a
hard disk, CD or jump drive. Then put the used storage device into the IOS’s
disk drive or USB port and finally, copy the .stb file into the IOS’s Script Root
folder. This folder is found in “C:\share\IOS\scripts.” Both the .stb file and the
folder with the same name must be copied.

4. A Script may be run directly from the storage device without saving the Script
to the IOS. Select the IOS option File -> Open. Select the desired Script and
press the Open button as shown in Figure 45 below. The Script then opens
like a regular Exercise.

Figure 45 – Using the File Open command to Load a Script
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Lesson Plans (Building and Using)
The Lesson Plan feature allows an Instructor to quickly construct a varied curriculum
made of a series of desired training Scripts. A Lesson Plan holds a sequence of Scripts
with the ability to move from one Exercise to the next more efficiently. Use the
procedure that follows to create and use a Lesson Plan:

STARTING A NEW LESSON PLAN-

 Click the Edit->Lesson Plan menu option from the IOS Program Menu to start a Lesson
Plan as shown below in Figure 46.

Figure 46 – Starting a New Lesson Plan

 Immediately the Lesson Plan Builder window will pop up shown in Figure 47 below.

Figure 47 – Lesson Builder Window

If a Lesson Plan is MODIFIED then it must be SAVED under a
DIFFERENT name. The program does NOT allow the user to resave a
Lesson Plan with the same name.

Work box
for Scripts
and IOS

Scenarios
that will be
part of the

lesson.

The “Move”
and “Delete”

Buttons

Lesson Plan
descriptions
added here.

Existing
Lessons can
be pulled up

here and
modified
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ENTERING A LESSON PLAN NAME AND DESCRIPTION-

 Type in a desired lesson name in the “Lesson Name” Textbox and a description of the
lesson plan in the “Lesson Description” textbox, as shown below in Figure 48.

Figure 48 – An Example of a Lesson Plan Name and Description

A Lesson Name should describe what the lesson covers and the Lesson Description
should include the purpose, student directions, length of exercise, total time for the
Lesson Plan, instructor cues, and anything else that may be necessary for other
Instructors who did NOT create this Lesson Plan to know to fully understand the Lesson
Plan.

This Lesson will take the Instructor through an introductory
session of the city driving then progress into an intermediate
level script with a police vehicle.

Introductory Driving

Press
Save
when
completed
.
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LOADING SCRIPTS INTO THE LESSON PLAN-

 Select a Script for your Lesson Plan by dragging and dropping it into the right-side
workbox in the Lesson Plan Builder Window as shown in Figure 50 below

 Or use the large black arrow (outlined in red in Figure 50) in the middle of the two
workboxes to transfer the desired Script(s) to the right-side window.

Figure 51 – Moving a Selected Script to the Right-Side Workbox to
officially add the Script to a Lesson Plan
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POSITIONING SCRIPTS IN THE WORKBOX-

 Once ALL the desired Scripts are in place in the right side workbox in the Lesson Plan
Builder Window, they can be re-positioned in any desired order for use.

To move around the Scripts in you Lesson Plan, select the Script(s) you want to
move and use the “up/down” arrows on far right to move and position the Scripts
in the desired order as shown in Figure 52 below.

To remove a selected file simply highlight and click the Red X button on the right

Select the Script. Each
click on the up arrow
button (or down) will
move the Script one line
up (or down)

Keep clicking the up or
down arrow buttons to
move the file to desired
position.

Select the Script and
then click on the Red X
button to delete it.

Figure 52 – Moving and Deleting Scripts in a Lesson Play
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SAVING A LESSON PLAN-

 Once finished putting together your Lesson Plan with your desired Scripts in order,
select the “Save” button in the bottom right corner of the Lesson Plan Builder window
shown below in Figure 53.

Figure 53 – Saving a Lesson Plan

 A “Select File to Save Lesson As” window (Figure 54) will pop up. The default folder
location is “Lessons” shown in the “Save in” textbox. Enter a descriptive lesson name in
the “File Name” textbox at bottom of window. This file will be saved as a .lpn file type.

Figure 54 – “Select File to Save Lesson As” window

Test Lesson
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 Once saved the new Lesson Plan will appear under the Lesson Plans heading in the
Exercise Form’s Left Panel. Listed in its sub-menu are the individual Scripts making up
that Lesson Plan that were chosen previously. See Figure 55 below.

Remember, if your system has Scenarios, they can be included in Lesson
Plans as well.

Figure 55 – Newly Saved Lesson Plan listed in “Lesson Plans” on Exercise Form

Lesson Plans can be deleted by right clicking on the desired Lesson Plan
from the Left Panel on Exercise Form and selecting “Delete”.
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USING THE LESSON PLAN-

 The newly built Lesson Plan now can be dragged and dropped like any other Exercise
into the working area on the IOS Workspace window to be loaded (see Quick Start
Guide Pg. 13 for how to do this).

 Once it is loaded onto the IOS Workspace the Exercise Form will appear as shown
below in Figure 56.

Figure 56 – The Lesson Plan’s Exercise Form

 Select the “Load Exercise” button to run the first Script in the Lesson Plan. Use the
arrows on the right side of the Exercise Form to scroll through the Scripts.

 Clicking the Lesson Plan icon toward the upper right corner brings up the
description of the Lesson Plan.
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In a Linked Exercise Lesson Plan
where more than one student vehicle is

participating in the Lesson Plan, the
current Exercise can be advanced,

stopped and/or restarted for ALL the
students simultaneously

LESSON PLAN CONTROLS-

The Lesson Plan Controls are located at the bottom left corner on the IOS Workspace
Window once the Lesson Plan is started/loaded as shown below in Figure 57.

Figure 57 – Lesson Plan Controls buttons

The “Run All” button starts the Lesson Plan and the “Next All” button advances the
Lesson Plan. “Run All” will start several Lessons Plans if more than one Plan is being
run.

If a Lesson Plan with a SINGLE student vehicle is run, the “Load Exercise” button,

Stop button and the double arrow buttons are used on the individual
Exercises in the Lesson Plan.

WARNING! If a Linked Exercise is run and then is switched to a single
student Exercise, the program may suspend operation.
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Real-Time Scoring Graphs Details

PLACING GRAPHS ON THE FORM-

Basic Real-Time Scoring Information is available in the section Advanced Option
Details and Operations under specifically the Real-Time Scoring Button Pg.40

The Real-Time Scoring Form is completely configurable. The monitored scoring
parameters may be added and deleted to suit specific training objectives. The following
process will enable an Instructor to create and modify Real-Time Scoring Forms.

 To add or delete scoring parameters, unlock the control through Options ->
Unlock Control in the upper left hand corner of the Exercise Form.

 If there are NO graphs OR a NEW graph needs to be added to the form,
select Options -> Show Toolbox to bring up a list of available scoring
parameters (labeled “Scoring Items” as seen in Figure 58 below)

 Drag and drop items from the “Scoring Items” list to the right-side panel to get
graphs to appear. (In Figure 58 below the example used is “Soft Shoulder
Violations”; it is being taken from the “Scoring Items” list and dragged over to
create the “Soft Shoulder Violations” graph on the Form’s right side.)

Figure 58 – Adding a New Graph to the Real-Time Scoring Form

 To delete already created graphs, right click on the graph and select “Delete.”
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Blue squares
signify the
reference

graph.

Green
squares

signify the
secondary

graph.

ALIGNING GRAPHS ON THE FORM-

Graphs on the form can be resized or moved in a number of ways.
If there is difficulty lining up graphs use the “Align” options accessible through the top
menu on the Real-Time Scoring Form as seen in Figure 59 below.

Figure 59 –Align Graphs on Real-Time Scoring Form

 The first graph selected contains blue re-size squares around its border.
Holding the “Shift Key” on keyboard and clicking on one or more other graphs
creates the desired selection group of graphs.

 This blue squared graph is the primary reference while each graph clicked on
after the primary graph is a secondary reference and highlighted in green
squares.

 If any of the “Align Options” (“Left , Top, Width, Height”) are selected at this
time, all secondary graphs will match the specified dimension of the primary
reference graph. For example, if “Top” is selected from the “Align Options,”
all graphs in the selection group will align their tops with the primary graph
that has the blue squares.
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MONITORING THE SCORING SHEET-

The Real-Time Scoring Form can monitor UP TO FOUR drivers simultaneously. In
Linked Exercises, the vertical bars on the graphs are split to represent each student
vehicle’s stats as shown below in Figure 60 using a “Steering” graph as an example.

Figure 60 – How the graph bars change
to reflect each/all student vehicles in an Exercise

Note in a two-driver Linked Exercise, the graph bars are split in half (middle
graph) and in a four-driver Linked Exercise the bars are split in quarters
(right graph).

Two vehiclesOne vehicle Four vehicles
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SETTING ERROR LIMITATIONS FOR STUDENT DRIVERS –

The Instructor has the ability to set limits on the number of errors a student can make
through the Real-Time Scoring graphs. By simply adjusting the Graph Values as seen in
Figure 61 and Figure 62 below, an Instructor can ensure the number of appropriate
errors is NOT exceeded in each area (example below is “Stop Sign Violation”).

 Right click on the graph that you want to adjust (Figure 61) and the “Adjust Graph”
Selection Form will pop up.

Figure 61 – Selecting “Adjust Graph Values”

Figure 62 – The “Adjust Graph” Selection Form

Student graphs exceeding a limit will turn to yellow, orange, and then
red depending on the alarm limit set and the student’s error level.

Alarm values will
trigger around the
Value set or the
Event that is set.

In this example with
Stop Violations if the
student exceeds
running two Stop
Signs in the
Exercise, the Stop
Violations graph bar
would turn red.

Note that the
Speed Limit
would be listed
here if this were
the Speed Limit
Selection Form
for the Speed
Limit graph
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 Change the values in the upper left boxes on the “Adjust Graph” Selection Form (shown
in Figure 63 below) to adjust the maximum and minimum measurements of the item
being scored.

Figure 63 – Graph Values On “Adjust Graph” Selection Form

 Change values in the boxes in the upper right corner of the “Adjust Graph” Selection
Form (shown in Figure 64 below) to adjust the graduated numerical intervals and the in
between dividing marks that measure the scored item.

In the figure below the graph (on right) is in intervals of two (showing 6, then, 8, 10, 12)
because the “Big Tick Increment” (on panel on left) was entered as 2. Then there are
four dividing marks in between each interval on the graph because the “Number of
Small Ticks For each Big Tick” on the panel has 4 entered.

Figure 63 – Graph Values On “Adjust Graph” Selection Form
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 To determine whether “Value” or “Event” is measured, select from the two button circles
at the bottom of the Adjust Graph” Selection Form (labeled Value or Event) shown
below in Figure 64.

Figure 64 – The Value and Event selections on Adjust Graph” Selection Form

Selecting “Value” would be used for graphs like “Following Distance”.

Selecting “Event” would be used for violations like a “Stop Sign” or “Speed Limit”.
Use the drop-down box for selecting “Events”.

 Set alarm limits (an offset to Value or Event) by using numeric values and checking
“Enable” in the boxes on the lower left hand side of Selection Form.

When the “Value” button is selected the instructor must enter a numeric value into the
text box below the Value button. Alarm limits will then work off this value.

If the instructor selects an “Event,” the graph receives numeric information from the
Visual World and the alarm limits will work off the selected event. An example of an
Event received from the application is the Speed Limit.

Note NOT all Events work. If there is not any numeric values
programmed in the Visual world, then the graph will not show any
change.

 Select the “Apply” button at the bottom of the Selection Form when the graph properties
are complete. Click the Red X Button in the upper right corner of the Selection form to
Exit. (See these buttons in Figure 62 on previous page if necessary)
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SAVING SCORING/GRAPH CONFIGUARTIONS-

Creating an effective scoring configuration is essential. It is important for an Instructor
to save effective scoring configurations to use with specific driving exercises.

 Once the graphs and scoring are set up as desired for a particular training
purpose, save it by selecting Options -> Save Configuration as shown below
in top image of Figure 65.

 The “Scoring Config” directory folder has the default label default.scx. Give
your new “Scoring Config” file a descriptive name in the “File Name” textbox
at bottom of “Save Scoring Layout” window shown as bottom image in Figure
65.

 Select the “Save” button and your new scoring configuration file is saved in
the correct scoring directory.

Figure 65- Saving Scoring Configurations
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LOADING SCORING/GRAPH CONFIGURATIONS-

 To load your Scoring Configuration Select Options  Load Configuration from
the Scoring Options Menu as shown in Figure 66 below.

 In the “ScoringConfig” directory select the desired scoring file by left clicking
on it. The name should appear in the “File Name” box.

 Select “Load”.

Figure 66 – Selecting the “Load Configuration” Option

Note this is where the importance of a descriptive name becomes
vital. Selecting the correct Scoring Configuration file can be
difficult if the name does NOT tell the user what the scoring
graphs are or what they are meant to be used with.

Regardless however, if the wrong configuration is selected and
loaded, the user can go back and select another configuration until
the correct one is found.


